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Steps to Request Installation of “Above Core” software through the OCIO-CEC’s DWP 

Double-Click the OCIO Help Icon on your desktop 

Hover over the Online Help icon and Click Submit DWP Request 

You’ll be signed in through the single sign-on eAuth process to the CEC Digital Workplace home page… 

Scroll down to the “Top Service Requests” section and Click “Install/Uninstall Software…” 
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Select the appropriate action/install options (for yourself, install), and choose either “Yes” or “No” for “Do you 
need Agency Specific Software”. Click the “Name of Software” “Select” dropdown, and in the “Filter:” header, 
start typing the name of the software (.e.g. “Autodesk”, “HEC-HMS”, “MAGNET”, etc.).  You’ll have to 
experiment with the “Yes/No” selection and names to possibly find what you’re looking for.  If what you’re 
looking for doesn’t populate, leave the agency-specific option set to “No”, and enter/select “Other” for the 
name of the software. 
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Populate the Software name, version, date, etc. as shown here (this example is for MAGNET Tools). Enter the 
CRQ # if known (can be found by searching the CEC-OCIO ITR Software SharePoint): 

Click 

https://usdagcc.sharepoint.com/sites/ocio_itr/SitePages/software.aspx
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User Setup of NRCS Customization for Autodesk Civil 3D 2022 Software 
Windows 10 CCE 

 
About 

Support files & tools for use with Autodesk Civil 3D 2022 software in support of the National NRCS 
CAD standards are deployed separately from Civil 3D 2022. After the NRCS customization files are 
installed, user customization settings need to be completed within the login for each individual user. 
 
Do this first: In Windows Search, search for and open the Control Panel app. 

 

 
 
Click Programs, then click Programs and Features. Filter the “Publisher” column as shown below. 
Confirm that Civil 3D 2022 and all add-ons/extensions have been installed. If your list of programs does 
not match this list, the installation may have been interrupted; contact IT for assistance before continuing 
with these instructions. 

 
Do this second: Confirm that the NRCS Customization files have been installed. 

Open Windows Explorer and Browse to C:\ProgramData. Confirm that the CAD Std 2022 folder exists, 
and that it contains the following folders: 
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Browse to C:\ProgramData\Autodesk\C3D 2022. Confirm that the SupportNRCS folder exists, and that it 
contains the following folders/files: 

 
 
If either of those folders is missing or files/folders within either are missing, the NRCS Customization 
installation process was likely interrupted. Contact IT for assistance or check Software Center to retry the 
installation. 
 
Do this third: Set Windows Explorer to show hidden folders.  
In Windows Explorer click View. Then within Show/hide, checkmark Hidden items & File name 
extensions: 
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NRCS Customization File 

If you don’t see the “Program Data” folder after the install, you can install it from the software center: 

Type in the search bar “software center” and select it 

 

Under Applications, you can search for NRCS Autodesk Civil 3D 2022 Customization 1.0 

 

Select it and then you can click Install 
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Once completed, you can check in the following file location to verify the file was installed: 

C:/ProgramData/Autodesk/C3D 2022/SupportNRCS 
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Activating the USDA Network License for Autodesk Civil 3D 2022 
 
Launch Civil 3D 2022 Metric 

 
 
An “Unsigned Executable File” warning may appear, asking if you want to load the “TableExport2022.dll” file. 
If it does, click Load Once. 

 
The “No active subscription or trial..” screen will appear. Click Already have a License? 
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On the “Let’s Get Started” screen, click Select under “Use a network license” 

 

From the top of the Civil 3D 2022 software window click the dropdown  to the right of Sign In. 

 
 

Select “Manage License…” 

 
If  Borrow  is showing, the network license is running 

 
 

If the steps and screenshots on these first two pages don’t appear or work, continue for other license activation 
processes that may work. 
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In some instances, a product license activation or “Start Trial” screen will appear. 

    Click Run. If you click Activate, just click Close and OK to get 
back to the product activation screen. 
 
OR click Start Trial 
 

    
 
A trial mode of Civil 3D 2022 will start. 
 
From the top of the Civil 3D 2022 software window click the dropdown  to the right of Sign In. 

 
 
Select “Manage License…” from the dropdown list 
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The License Manager screen will appear. Click Activate. 

 
 
 
One of these Let’s Get Started windows will appear. 

 

Or  

 
Click the Select button in the “Use a network 
license” section. 

 Click the Multi-user button 
 

 
Civil 3D will then be connected to the USDA network license manager. 
 
IF after Selecting “Use a network license” the “Specify a license server” screen appears… 
 

 

And 

 
 
This means the full installation of Civil 3D, add-ons/extensions, and the licensing service files were probably 
interrupted at some point during the process.  Refer to the User Setup document for full details and contact IT 
for assistance if it appears the installation is not complete. 
 



Resetting an Expired Trial License 
NRCS Civil 3D 2022 1 11/1/2022 

Steps to Activate the Network License if the Autodesk Civil 3D 2022 Trial License has Expired 
 
If you launch Civil 3D 2022 and see a screen noting that your license has expired, you will need to take 
some extra steps to reset it. 

 
Quit out of Civil 3D 2022. 
 
In the Windows Search box type {cmd} [enter] 
The Command Prompt window will open. 
Type (or paste) the contents inside these {} at the Command Prompt cursor 
{cd /d "C:\Program Files (x86)\Common Files\Autodesk Shared\AdskLicensing\Current\helper"} 
[enter] 
Type (or paste) 
{AdskLicensingInstHelper change -pk 237N1 -pv 2022.0.0.F -lm ""} 
[enter] 
Close the Command Prompt 
 
Launch Civil 3D 2022 Metric 
An Autodesk Licensing screen will appear noting that your trial license has expired: 

 
Click “Already have a license? >”. 

License Expired 
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Then a Let’s Get Started screen will show up  

 
Click the Select button in the “Use a network license” section. 
 
Civil 3D will then be connected to the USDA network license manager. 
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User Setup of Civil 3D 2022 using National NRCS deployment 

Note: If a user had launched Civil 3D 2022 Imperial prior to the installation of the NRCS customization 
files, then the user will first need to reset Civil 3D 2022 for their login. (See Resetting AutoCAD Civil 
3D instructions on the final page.) 
 
1) Launch Civil 3D 2022 Metric via Start… Autodesk Civil 3D 2022 - English… Civil 3D 2022 Metric. 

2) Refer to the “Activating Autodesk Civil 3D 2022 Network License” document, if applicable (and/or 
“Activating Expired Trial Autodesk Civil 3D 2022” document, if applicable). 

2) Type Options [Enter] to pull up the Options dialog box. Select the Profiles tab. 
a) Highlight <<C3D_Imperial>> and Click Rename and then rename it to 

Original<<C3D_Imperial>> 
b) Click Apply & Close. 
c) Click Import… then Browse: to  

C:\ProgramData\Autodesk\C3D 2022\SupportNRCS 
d) Select Civil3D_Imperial 2022_NRCS.arg and Click Open. 
e) Rename the Profile name to <<C3D_Imperial>> and checkmark Include path information. Be 

sure to include the “<<” and “>>” in the name.  
f) Click Apply & Close. 
g) Click OK to exit the Options dialog. 

3) Quit out of Autodesk Civil 3D 2022 by clicking Exit from the Application Menu.  

      
 
4) Click No when asked to save changes to the drawings. 

5) Launch Civil 3D 2022 Imperial via Start… Autodesk Civil 3D 2022 - English… Civil 3D 2020 
Imperial 

6) If the Autodesk Data Collection and Use window appears, you can decide whether to participate or not. 
Select your choice and Click OK. 

7) If the TableExport2022.dll “Unsigned Executable File” warning appears, select Always Load. 

8) Move your Toolspace to your preferred screen location or click on the Toolspace AutoHide and 
Properties to change docking, etc. 

9) Trimble Link (A - Enable, B - Register or C - Disable). Trimble Link tools can be used to transfer data 
between AutoCAD and Trimble surveying devices. 

Option A) To load the Trimble Link tool (add to the ribbon). 
1. Type CUI, Press Enter 
2. Within the Customize tab, Right-click on Partial Customization Files 
3. Click Load partial customization file 

 
4. Browse to C:\Users\first.last\AppData\Roaming\Autodesk\C3D 2022\enu\Support  
5. Select TrimbleLink.cuix to highlight and Open 
6. Click OK to close the CUI 

Option B) To register Trimble Link if you have not registered an earlier version: 
1. Initialize a Trimble Link command from the ribbon. (The following steps will not be needed 

if registration has already been done.) 
2. An Authorize box will appear. Click Yes I Agree. 
3. Click on the link to the Trimble registration page and complete the information. 
4. A registration key will be provided. Or use: 64251726 
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5. Enter the registration key into the Authorization code of the Authorize Trimble Link dialog.  
6. Click OK 
7. The Trimble Link tool will be enabled.  Click OK 

Option C) To unload/disable the Trimble Link tool.  
1. Type CUI, Press Enter 
2. Within the Customize tab, expand the Partial CUI files list in the left column. 
3. Right-click on TRIMBLELINK  
4. Click Unload TRIMBLELINK.CUIX file 
5. Click OK to close the CUI 

10) Import the NRCS Waterway subassemblies 
From the Civil 3D 2022 ribbon use Insert… Import…Import Subassemblies… 

Prior to Importing the .pkt files, select Create New Palette at the bottom of the dropdown list to 
make a new tab named My NRCS WW. 

 
 
 
 
 

Set the Tool Palette to My NRCS WW (or select an existing tab, if desired) 

At Source File, browse to C:\ProgramData\Autodesk\C3D 2022\SupportNRCS\WW 
Subassemblies.  
You can select all of the .pkt files using Control+Click. Click Open.  
Click Ok.  
The My NRCS WW tab with the subassemblies will be added to your current Palette. 

11) Exit Civil 3D Imperial and relaunch. 
  

Pulldown to the bottom of the list 
to click Create New Palette… 
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Optional: Customizing workspace menus & tool bars 
 
To Toggle on/off the Toolspace, Properties, or Tool Palettes use the ribbon via Home… Palettes…. 

 
Any of these palettes can be docked or anchored by right clicking on the 

palette title and clicking the anchoring or docking options. 
 

 
 
 
Press Ctrl+ 3 to toggle Tool Palettes on/off. 
When you Right-Click on the Tool Palette bar 
you can switch to the NRCS 11x17 or NRCS 
22x34 groupings. 
 
 
 

 
To add the “11x17 MapSymbols B” palette to the NRCS 11x17B palette grouping: 

1. Expand/unhide (if auto-hidden) Tool Palettes and right-click ON the tool palette bar 
2. Select “Customize Palettes…” 
3. <Left-click>-drag the “11x17 MapSymbols B” palette into the NRCS 11x17B palette group, in 

between “11x17 Symbols B” and “11x17 Scales B” 
 

    
 

4. Click Close 
5. Right-click on the “11x17 MapSymbols B” palette tab and select View Options… 
6. Drag the “Image size:” slider all the way to the left and click OK 
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To unload an entire Partial CUI from a profile (this makes them unavailable to all workspaces in the 
profile): 

1. Type CUI, Press Enter 
2. Within the Customize tab, expand the Partial CUI files list in the left column. 
3. Right-click on the Partial CUI to be removed (TRIMBLE, TOPCON, etc),  
4. Click Unload CUI file. 
5. Click OK to close the CUI. 

 
To enable/disable some menus and/or toolbars in an individual workspace: 

1. Type CUI, Press Enter 
2. Highlight the Workspace to be customized in the left column,  
3. Click Customize Workspace in the right column.  
4. Check/Un-Checkmark toolbars or menus under the Main, Partial, or Enterprise CUI list on 

the left side to make them appear or not appear within the selected workspace. 

For example, if for some reason the NRCS tab isn’t showing up in the ribbon, the first thing 
to check is if “Tabs” is checked for the NRCS (Enterprise) ribbon… 

 
5. Click OK when done to save the changes and have them take effect. 

 
To save changes to the location of the palettes in a workspace: 

1. Click the Workspace Switching in the Quick Launch toolbar and click Save Current As. Then 
select the current workspace or input a new name. Click Save. 

 
 

To switch workspaces: 
1. Click the Workspace Switching in the Quick Launch toolbar and select the desired 

workspace. 
(The software will open next time using the Workspace that is active when you exit out of CAD.)  

 
IMPORTANT NOTE for Topcon MAGNET Tools Users: 

The installation order of Civil 3D and Topcon MAGNET Tools is extremely important. If 
MAGNET Tools is/was installed before Civil 3D, the Topcon ribbon will be present, but the 
commands will not work. 
MAGNET Tools must be uninstalled prior to installing Civil 3D 2022, then reinstalled after. 
 
After installation of MAGNET Tools, upon first launch of Civil 3D 2022, the following prompt 
will appear, and the Topcon tab will be present in the ribbon. 
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For Reference Only: 
NRCS Custom Options settings for Autodesk Civil 3D 2022 on Windows 10 

 
These are settings changes that the NRCS Customization has included: 
Type Options [Enter] to pull up the Options dialog box. Select the Files tab. Add the following settings 

using the Browse or Add buttons if these are not already preset: 
 
Support File Search Path (in addition to default paths) 

C:\ProgramData\Autodesk\C3D 2022\SupportNRCS\Macros 
C:\ProgramData\Autodesk\C3D 2022\SupportNRCS\Interface  

Trusted Locations… 
C:\ProgramData\Autodesk\C3D 2022\SupportNRCS\Macros\... 
C:\ProgramData\Autodesk\ApplicationPlugins\... 

Customization files…  
Main Customization file… 

C:\User\{user.name}\appdata\roaming\autodesk\c3d 2022\enu\support\c3d 
Enterprise Customization file… 

C:\ProgramData\Autodesk\C3D 2022\SupportNRCS\Interface\nrcs_c3d.cuix 
Template Settings… Drawing Template File Location… 

C:\ ProgramData\CAD Std 2022\Templates 
Template Settings… Sheet Set Template File Location… 

C:\ ProgramData\CAD Std 2022\Templates 
Template Settings… Default Template File Name for QNEW… 

C:\programdata\cad std 2022\templates\nrcsc3d2022(11x17)r1.dwt 
Tool Palettes File Locations… 

C:\Users\{user.name}\appdata\roaming\autodesk\c3d 2022\enu\support\toolpalette 
C:\programdata\autodesk\c3d 2022\supportnrcs\toolpalette\text_blocks_b 
C:\programdata\autodesk\c3d 2022\supportnrcs\toolpalette\nrcs_lines 

Temporary Drawing File Location… 
C:\Users\{user.name}\appdata\local\temp\ 

Temporary External Reference File Location… 
C:\Users\{user.name}\appdata\local\temp\ 

Click OK to have the changes take effect. 
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Resetting Autodesk Civil 3D 2022 settings for a User 
If a user has previously launched Civil 3D 2022 prior to the installation of the NRCS customization files, 
then the user will first need to reset Civil 3D 2022 for their user login.  
 
Reset Civil 3D 2022 user profile the easy way: 
1. Click Start… Autodesk Civil 3D 2022 - English… Reset settings to Default… 
2. At the Reset Settings – Backup Screen you can click Reset custom settings unless you know of a 

need to back them up. 
3. At the confirm screen click OK. 
4. Then Civil 3D launches as plain AutoCAD 2022.  
5. Quit out and redo your user customization. 
 
Or  
Reset Civil 3D 2022 user profile manually: 
Log on to the computer as that user. 
1. In the Start menu “Type here to search” box, start typing regedit 
2. The Registry Editor App will appear as a “best match”. Click to open the app. 

 
 

3. In the Registry Editor, browse to the following key and delete it: 
HKEY_CURRENT_USER\Software\Autodesk\AutoCAD\R24.1\ACAD-5100:409 

5. Close the Registry Editor. 
6. Using Windows Explorer, browse to and delete the following user's application folders: 

C:\Users\<user>\AppData\Roaming\Autodesk\C3D 2022 
C:\Users\<user>\AppData\Local\Autodesk\C3D 2022  

 

NRCS computers allow this 
regedit change without 

needing an administrator. 



Object Highlighting & Layer Isolate Settings 

AutoCAD has a feature where objects are highlighted when the pickbox cursor rolls over them, providing a 
preview of which object will be selected when you click it. This does slow down a computer somewhat and can 
sometimes be a bother. 

If you would like to change the settings go to: 

Application Menu… Options… Selection 

Many users like to uncheck “When no command is active” and leave the other one checked. That means object 
highlighting occurs only after you’ve started a command such as move, copy, rotate, etc.  Some like to uncheck 
both. 

 

Command preview controls whether you can preview the outcome of the active command (e.g., see fillet curves 
applied before picking a polyline). Recommend leaving it checked. 

Property preview controls whether you can preview the changes to currently selected objects when you roll over 
drop-down lists and galleries that control properties (e.g., see the chosen color of the selected object before 
picking it in the Properties color drop-down). Recommend leaving it checked. 

Click Visual Effects Settings… to change how the highlighted object is displayed. 



The Layer Isolate command can be set to either Lock and fade layers or to Turn off or Freeze layers. 

To modify the settings, go to the Home tab of the ribbon, Layers panel, and click Layer Properties 

Open the Settings by clicking the gear icon… 

 

The usual choice is to turn the layers that are not isolated off. 

 

Tip: To quickly isolate every layer in a project one at a time to simply see what’s contained on it, use the 
LayerWalk command. 

 

Highlight the first layer in the list, then use the keyboard down arrow key to quickly display only what’s on each 
layer. 

 



Steps to Activate Grading Optimization for Civil 3D 2022  

 

Launch Civil 3D 2022 Imperial 
On the Home tab of the ribbon select Grading Optimization 

 
 

At the trial license screen click “Already have a License? >” 

 

At the Let’s Get Started screen go to the Use a Network license area and click Select 

 

Once activated, Grading Optimization tools are accessed via the Analyze tab of the ribbon 

 



NOTE: Clicking Grading Objects will open the Grading Objects Browser and activate ALL tool palettes 
to access the grading objects… 

 

To switch back to the NRCS 11x17B and 22x34B tool palettes, simply hover over and right-click on 
TOOL PALETTES – ALL PALETTES and select accordingly… 

 

Right-Click 
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Steps to Activate Autodesk Project Explorer for Civil 3D 2022  
 
Launch Civil 3D 2022 Imperial 
On the Home tab of the ribbon select Project Explorer (Moved from previous Add-Ins location in 2020). 

 
 
At the trial license screen click “Already have a License? >” 

 
At the Let’s Get Started screen go to the Use a Network license area and click Select 

 
 
Project Explorer for Civil 3D will open as a separate window in C3D and gives additional tools for reviewing 
Civil 3D surfaces, alignments, profiles, corridors, generating custom reports, and more. 
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1. C3D Template Files have been renamed as follows: 
a. NRCSC3D2022(11x17)R1.dwt 
b. NRCSC3D2022(22x34)R1.dwt 

2. Updated NRCSC3DTitleBlocks.dwt by adding 11x17 and 22x34 layouts for section sheet 
production at 1” = 20’ scale 

3. AutoCAD Standardized Components 
a. Linetype (nrcs.lin) 

i. Created OH (Overhead) linetype with OH for text 

 

ii. Created Easement linetype 
 

 
b. Layers 

i. Added V.Poin.Stak, for proposed staking points (1, Continuous, Proposed 
Staking Points) 

ii. Renamed W.Plan.Util layer to W.Plan.Util.Ugnd, and updated layer description 
(this layer already references an underground linetype) 

iii. Added W.Plan.Util.Ovhd and assigned OH linetype 
iv. Added C.Prop.Easmt 
v. Added C.Prop.Setback 

c. Dimension Styles 
i. Removed the following dimension styles from C3D 22x34 (D) DWT 

 

d. Text Styles 
i. Removed the following text style from C3D 22x34 (D) DWT 

 

ii. Added the following text styles to both C3D DWT’s 
1. NRCSC3D2022(11x17)R1.dwt: 001xB_Notation(A), romans.shx, .063, 22 

degrees 
2. NRCSC3D2022(22x34)R1.dwt: 001xD_Notation(A), romans.shx, .125, 22 

degrees 
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e. Blocks 
i. The following GIS (Mapping) blocks have been added to the 11x17 and 22x34 

tool palettes 

 

ii. Added PivotIrrigation Dynamic Block for a pivot irrigation system 
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f. Tool Palette Updates 
i. Created “11x17 MapSymbols B” and “22x34 MapSymbols B” palettes in “NRCS 

11x17B” and “NRCS 22x34B” palette groups; added all above new GIS map 
symbol blocks to the appropriate palette “b” and “d” palettes. 

    
 

ii. Placed “PivotIrrigation Dynamic” block in both “11x17 Symbols B” and “22x34 
Symbols B” palettes 

iii. Created new “Property Line – Easement”, “Property Line – Easement Setback”, 
“Utility Line – Overhead” polyline tools in the PLAN Commands palette. Edited 
existing “Utility Line” to “Utility Line – Underground”. 

4. Civil 3D Standardized Components 
a. Dragged State Arrowhead Sizes 

i. All C3D label styles in NRCSC3D2022(11x17)R1.dwt have been updated to have 
a height of 0.117 (formerly 0.078) 
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ii. All C3D label styles in NRCSC3D2022(11x17)R1.dwt have been updated so 
dragged state leaders are splined, and not straight 

iii. All C3D label styles in NRCSC3D2022(22x34)R1.dwt have been updated to have 
a height of 0.234 (formerly 0.156) 

iv. All C3D label styles in NRCSC3D2022(22x34)R1.dwt have been updated so 
dragged state leaders are splined, and not straight 

v. The 4 items above were done to match NRCS text, multileader and dimension 
styles 

b. General  Multipurpose Styles  Code Set Styles 
i. Deleted Corridor Production CSS and updated Corridor CSS to include point 

codes from NRCS custom waterway subassemblies 
ii. Deleted Waterway (Corridor Design) and Waterway (Sections with Labels) CSS’s, 

as they duplicate the functionality of the Corridor and Section (With Labels) CSS 
iii. Updated Section (Corridor Section Editor) CSS to include point codes from NRCS 

custom waterway assemblies 
iv. Deleted Section (Drawing Production) as it is duplicated with Section (With 

Labels) CSS 
v. Resulting set of CSS’s is as follows: 

 

c. General  Multipurpose Styles  Label Styles  Marker 
i. Modified Offset (Drawing Production) so the negative value is not shown on a 

left side offset label.  These labels use a L and R as a suffix to indicate the side 
ii. Removed Offset and Elevation as this is a duplicate for Offset and Elevation 

(Drawing Production). CSS referencing the old label style were updated 
accordingly. 

iii. Resulting set of maker label styles is as follows: 

 

d. General  Multipurpose Styles  Label Styles  Line 
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i. Grade and Elev Start End and Slope and Elev Start End have been updated so the 
grade is displayed on the middle of the segment 

e. Point  Description Key Sets 
i. Updated Z* code (in Z_Staking Description Key Set), to reference the new 

V.Poin.Stak layer 
ii. Deleted EDGE* in Edge DKS, as it conflicts with ED*, in the same DKS 

f. Point Groups 
i. Updated EX – Ground (Plain) point group to include GRD and GS point 

descriptions 
ii. Updated PR – Staking point group to remove With names matching: z*. Points 

with description Z* are included in the PR – Staking point group  
g. Surfaces 

i. Added Watershed Analysis surface style 
ii. Added Watershed label styles (watershed details and off) 

iii. Added Watershed table style 
h. Profile View Styles 

i. For both (11x17) and (22x34) DWT’s, the default profile view style was set to A 
40Hx10V to align with DWT current annotation scale of 1”=40’ 

i. Corridor 
i. Modified ViewEditCorridorSections command settings to assign the Section 

(Corridor Section Editor) as the default Code Set Style when this command is 
issued. 

5. Custom Applications 
a. AUXSP – Auxiliary Spillway has been updated to provide better instruction on the 

orientation of the auxiliary spillway.  The mirror option has been removed, and labels 
are now placed in the drawing to indicate the upstream and downstream sides 

 

b. CALCA – Calculate area command now supports C3D feature lines 
c. TOTLEN – Total length now supports a variety of entity types including lines, polylines, 

splines, circles and arcs 
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